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Section 4
Introduction

This document provides instructions on how to locate other TRAIN Florida courses and narrow
your course search by using the Advance Search features.

| This symbol indicates that additional help for the TRAIN Florida APD training resource,
instructions, or tutorials are available and located on the APD Training Portal web page.

If you have any problems and require technical assistance, please contact the TRAIN Florida APD
site administrator by email: apd.Imssupport@apdcares.org.

Section 4.1
How to Locate Other TRAIN Florida Courses from the TRAIN Florida Login Page

This section will show you how to locate other TRAIN Florida courses from the TRAIN Florida login
page.

Step 1
Begin your course search using the Keyword or Course ID search feature. The Keyword or Course
ID search feature is located on the upper right corner of the web page.

Step 2
To locate any TRAIN Florida course, enter a keyword into the Keyword or Course ID search field,
and then click the search icon button to the right of the field.

Weicome Guest! | Logh?

Florida Department of Health's

Official Learning Management System

Wednesday, February 03, 2016

m About Help Competencies HH”DAA “ N ls\g:racnhced

Image 4.0

For example, if you want to search for all HIPAA courses in TRAIN Florida, enter “HIPAA” into the
Keyword or Course ID search field.

Note: If you know the Course ID number, you can enter it into the Keyword or Course ID search field,
and then click the search icon button to the right of the field.

Rev.: 4/11/2016
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Step 3
After you click the search icon, the Course Search page will appear. This page lists all courses related
to your keyword “HIPAA”. The course titles are not listed alphabetically.

Search Parameters ]

Search Result A

Tip: To sort by any column, click the column heading. Or use default order by Keyword Search Proximity
Tip: To view course description, click on the Course Title

Tip: Alphabetical page indexing is used when sorted by Title, Sponsor/Offerer or Format.

$ = Fee associated with the course % = Credit is offered

20rowsperpage V| Fiter *ABCDEFGHIJKLMNOPQRSTUVWXY z[al
Displaying page 1 of 1, items from 1 to 6 of 6/

Title Type  Sponsor/Offerer Rating

Sedededey (1028)
4.3 out of 5 stars

HIPAA: An Overview Course  UNC Center for Public Health Preparedness

Public Health Nurses: Successful Partnerships with}
Ohio Schools-HIPAA, FERPA & Documentation Gadkaal| ok >chools ddolescent Healini;Schook edededesk (1)
(Independent Study) Nursing Program 5.0 out of 5 stars

Distinctions between Federal, State, and Local

Authority in Responding to Health Emergencies Course  TEGS-PERLC (no reviews)

Upper Midwest Preparedness and Emergency
Course Response Learning Center/Institute for Public (no reviews)
Health Practice

Prepare to Care: lowa's Direct Care and Support
Curriculum

Fededede s (8)
3.9 out of 5 stars
wkkk (2)
4.0 out of 5 stars.

20rowsperpage V| Fitr * ABCDEFGHIJKLMNOPQRSTUVWXY zal

Displaying page 1 of 1, items from 1 o 6 of §

oW Public Health Law Course South Central Public Health Partnership

oY Public Heaith Law (In Person / Streamed Live) Course Western Region Public Health Training Center

Image 4.1 I

Step 4
How to sort the course titles alphabetically.

Click on the word Title. The page will refresh and list the course titles alphabetically.

20 rows per page V|Filter *ABCDEFGHIJKLMNOPQRSTUVWXYZ
Displaying page 1 of 1, items from 1 to 6 of §

$ oy [ﬁl@ Type Sponsor/Offerer Rating

Image 4.2 I

Use the navigation options listed on the top portion of the page to help locate your course.

|I20rowsperpage VIFilter"ABCDEFGHIJKLMNOPQRSTUVWXYZ

Select page within selected Ietter:lrlqv Il 41 |2] 345678 [ ’,,,ﬂ M l Displaying page 2 of 8, items from 21 to 40 of 158
$ oy Title « - Type Sponsor/Offerer Rating

Image 4.3 I

Table of Content Next Page
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Section 4.1.1
How to View the Course Description and Register for the course

How to view the Course Description

Step 1
Once you have located the course, we recommend that you click on the Course Title to view the
Course Description.

r Course Search

Search Parameters v

Search Result

Tip: To sort by any column, click the column heading. Or use default order by Keyword Search Proximity
Tip: To view course description, click on the Course Title

Tip: Alphabetical page indexing is used when sorted by Title, Sponsor/Offerer or Format.

$ = Fee associated with the course  #% = Credit is offered

20 rows per page VFmef'ABCDEFGHIJKLMNOPQRSTUVWXYZ
Displaying page 1 of 1, items from 1 to 6 of 6
S o Title Type Sponsor/Offerer Rating

A sedededey: (1028)
o HIPAA: An Overview &< Course UNC Center for Public Health Preparedness 4.3 outof 5 stars

Public Health Nurses: Successful Partnerships with
oY Ohio Schools-HIPAA, FERPA & Documentation Course OBl Schoal & ftaieacent HicaltizSchcol hodododated

(Independent Study) Nursing Program 5.0 out of 5 stars

Step 2
After you click the Course Title, the Course Details page will appear. This page has four tabs:

HIPAA: An Overview

ICourse Detailsl \IContactsl \ |Registration] \ IReviewsI\\

Course ID: 1041019
Format: Web-based Training - Self-study (Online)

b Non Clinical
Course Number:
Cost (US$): 0.00

Credit Type(s): 0.75 Certificate of Attendance

Certificate:

Course Details Image 4.5
Contacts

Registration

Reviews

Table of Content Next Page
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a) Course Details - Provides a course overview.

[ Course Details Contacts Registration Reviews

Image 4.6 I

b) Contacts - Provides the course contact information

[ Course Details Registration Reviews

Image 4.7 I

c) Registration - Allows you to log in and register for the course.

[ Course Details Contacts IRegistration | Reviews

Image 4.8 I

d) Reviews - Allows you to see what other learners who have taken the course think about it.

[ Course Details Contacts Registration

Image 4.9 I

TIP! Return to the Login page by clicking the Home link.

How to Register for the Course

Step 1
The Registration tab allows you to register for the course.

Course Details Contacts IRegistration | Reviews

Image 4.10 I

Begin by clicking on the Registration tab.

Table of Content Next Page
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Step 2
Complete the steps below when the Registration page opens:

: - - X ; N\
Course Details \ Contacts 1 IReg|strat|on| \ Reviews \

To access this course, you first need to create an account: | Create Account

If you already have an account, please login: I:">E

Image 4.11

a) Click the Login button. This will return you to the TRAIN Florida login
page.

b) Use your account information and log in to TRAIN Florida.

c) The Course Details page will appear.

d) Click the Registration tab and register for the course.

Section 4.2
How to Locate other TRAIN Florida Courses from Your TRAIN Florida Home Page

The only way to locate TRAIN Florida courses from the Home Page is to use the Keyword or
Course ID search bar.

You can use the Keyword or Course ID search bar to locate any course or TRAIN Florida courses
available to your group assignment.

The Keyword or Course ID search bar is located on the upper-right side of the home page above the
Dashboard. Enter a keyword, such as part of a course title, or the course ID and search the TRAIN
database.

Advanced
Search

Image 4.12 I

Note: If you know the Course ID number, you can enter it into the Keyword or Course ID search field,
click the search icon button to the right of the field.

MCompetency Assessment Resources Discussions Help [Search by Keyword or Course ID C\'

Step 1
If you want to search for all HIPAA courses in TRAIN Florida, enter “HIPAA” into the Keyword or
Course ID search field.

Home Competency Assessment Resources Discussions Help :ﬁ- HIPAA Q, %:ra‘;:ﬁ

Image 4.13

Table of Content Next Page
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Step 2

After you click the search icon, the Course Search page will appear. This page lists all courses, live
events, announcements, resources, and discussion boards related to your “HIPAA” key word search
The course titles are not listed alphabetically.

Peovrsesoarsn ———————————————————————————————3

Search Parameters v

Search Result A

Tip: To sort by any column, click the column heading. Or use default order by Keyword Search Proximity
Tip: To view course description, click on the Course Title

Tip: Alphabetical page indexing is used when sorted by Title, Sponsor/Offerer or Format.

$ = Fee assoclated with the course % = Credit is offered

20 rows per page V| Fiter *"ABCDEFGHIJKLMNOPQRSTUVWXY Z|AI
Displaying page 1 of 1, items from 1 to 6 of 6
$ oy | Title Type Sponsor/Offerer Rating

sk (1028)
4.3 out of 5 stars

HIPAA: An Overview Course UNC Center for Public Health Preparedness

Public Health Nurses: Successful Partnerships with
Ohio Schools-HIPAA, FERPA & Documentation

(Independent Study)

Distinctions between Federal, State. and Local

Authority in Responding to Health Emergencies

ODH, School & Adolescent Health, School dedekeiedk (1)
Nursing Program 5.0 out of 5 stars

TECS-PERLC (no reviews)

Upper Midwest Prep and
Response Learning Center/Institute for Public (no reviews)
Health Practice

Prepare to Care: lowa's Direct Care and Support
Curriculum

o Public Health Law Course South Central Public Health Partnership 3.9 out of 5 stars

- 5 . i kR (2)
Public Health Law (In Person / Streamed Live)
o Public Health Law (In Person / Streamed Live Course Western Region Public Health Training Center 4.0 out of 5 stars

20rowsperpage V| Fitr * ABCDEFGHIJKLMNOPQRSTUVWXY Zzal

Displaying page 1 of 1, items from 1 to 6 of 6

Sededkks (8) ’

Image 4.14

TIP! A way to find all courses in this list is to sort the list by Type, and group the training courses
together. Click on the word Type in the column title. You can sort by Title, or Sponsor/Offerer, but be
aware that the list will mix the training courses in with other types of APD files.

Course Search

Search Parameters
Search Resuit

Tip: To sort by any column, click the column heading. Or use default order by Keyword Search Proximity
Tip: To view course description, click on the Course Title

Tip: Alphabetical page indexing is used when sorted by Title, Sponsor/Offerer or Format.

§ = Fee assoclated with the course % = Credit is offered

20rowsperpage V| Fiter *ABCDEFGHIJKLMNOPQRSTUVWXY z[Al
Displaying page 1 of 1, items from 1 to 6 of 6|
S oy Title —b Sponsor/Offerer Rating

Sy (1028)
4.3 out of 5 stars

oy HIPAA: An Overview UNC Center for Public Health Preparedness

Public Health Nurses: Successful Partnerships with
oY Ohio Schools-HIPAA, FERPA & Documentation

(Independent Study)
Distinctions between Federal, State, and Local
Authority in Responding to Health Emergencies

ODH, School & Adolescent Health, School sedededek (1)
Nursing Program 5.0 out of 5 stars

TECS-PERLC (no reviews)

Upper Midwest Preparedness and Emergency
Learning C for Public (no reviews)
Health Practice

Prepare to Care: lowa's Direct Care and Support
Curriculum

Sekekd s (8)
3.9 out of 5 stars

Rehekk s (2)
4.0 out of 5 stars

20rowsperpage V| Fiter *ABCDEFGHIJKLMNOPQRSTUVWXY ZAI
Displaying page 1 of 1, items from 1 to 6 of

o Public Health Law South Central Public Health Partnership

o Public Health Law (In Person / Streamed Live) Western Region Public Health Training Center

Image 4.15

ble of Content Next Page
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Use the navigation options listed on the top or bottom portion of the page to help locate your course.

20 rows per page vFilter"ABCDEFGHIJKLMNOPQRSTUVWXYZ
Select page within selected letter:| 14 | 4 1]2/3 4 5 6 7 8 » M| Displaying page 2 of 8, items from 21 to 40 of 158
$ oy Title « Type Sponsor/Offerer Rating

Image 4.16

Section 4.2.1
How to view the Course Description and Register for the Course

How to View the Course Description.

Step 1

Once you have located the course, we recommend that you click on the Course Title to view the
Course Description.

r Course Search

Search Parameters

Search Result

Tip: To sort by any column, click the column heading. Or use default order by Keyword Search Proximity
Tip: To view course description, click on the Course Title

Tip: Alphabetical page indexing is used when sorted by Title, Sponsor/Offerer or Format.
$ = Fee associated with the course ~ #% = Credit is offered

20rowsperpage V| Fiter *ABCDEFGHIJKLMNOPQRSTUVWXY z[al

Displaying page 1 of 1, items from 1 to 6 of 6
$ oy Title Type Sponsor/Offerer Rating

- - . *irdedy: (1028)
pre HIPAA: An Overview &) Course UNC Center for Public Health Preparedness 4.3 out of 5 stars

Public Health Nurses: Successful Partnerships with
o%  Ohio Schools-HIPAA, FERPA & Documentation e e e S rivime ol

(Independent Study) Nursing Program 5.0 out of 5 stars

Image 4.17 I

Table of Content Next Page
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Step 2
After you click the Course Title, the Course Details page will appear. This page has four tabs:

HIPAA: An Overview

ICourse Detailsl \| Contacts I\ | Registration | \ |Reviews|\\

Course ID: 1041019

Format: Web-based Training - Self-study (Online)
Clinical / Non-
Clinical:

Course Number:
Cost (US$): 0.00

Credit Type(s): 0.75 Certificate of Attendance
Certificate:

Non Clinical

Image 4.18

a) Course Details - Provides a course overview.

[ Course Details Contacts Registration Reviews

Image 4.19 I
b) Contacts - Provides the course contact information.

[ Course Details {; \(: Registration : Reviews \:

Image 4.20

c) Registration - Allows you to log in and register for the course.

[ Course Details \ Contacts \(: |Registration| : Reviews \:

Image 4.21 I

d) Reviews - Allows you to see what other learners think about it.

[ Course Details Contacts Registration Reviews

Image 4.22 I

TIP! Return to the Home page by clicking the Home link.

Table of Content Next Page
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How to register for the course.

Step 1
The Registration tab allows you to register for the course.

Course Details K Contacts \ |Registration| 5 Reviews \\J Image 4.23

Begin by clicking on the Registration tab.

Step 2
Complete the steps below when the Registration page opens:

a) Select the Credit Type.

b) Click the Launch button. Note: This course will be added to your My Learning after you click
the button.

Course Details
HIPAA: An Overview
Course Details \ Contacts Registration | Reviews \

Select Credit Type: | Certificate of Attendance v l<:

0

To launch this course,please click on the 'Launch’ button. Image 4.24
Note that this course will be added to 'My Learning' after you click the button.

You are now registered for the course

c) If applicable, any course material is forwarded to your email.

—|| The following TRAIN Florida learner resource is available to help you register and complete a
course. TRAIN Florida Learners Questions and Answers: How do | manage a TRAIN Florida
course?

If you have any problems and require technical assistance, please contact the TRAIN Florida APD
site administrator by email: apd.Imssupport@apdcares.org.

Table of Content Next Page



http://www.floridahealth.gov/provider-and-partner-resources/training/train-florida/_documents/qalhowdoimanageacourse.pdf
http://www.floridahealth.gov/provider-and-partner-resources/training/train-florida/_documents/qalhowdoimanageacourse.pdf
mailto:apd.lmssupport@apdcares.org

@99 & CONNECTING YOU TO THE COMMUNITY

Section 4.3
How to Use the Advance Search Feature to Find Courses

The Advanced Search feature is available on all TRAIN Florida screens, located on the top
navigation bar, to the right of the Keyword or Course ID search field. Click on the link to the
Advanced Search page.

Advanced

Home Competency Assessment Resources Discussions Help | ISearch by Keyword or Course ID" QJ | Search

Image 4.25

On this page, you can perform searches that are more detailed, browse for specific courses or use the
filter features to locate multiple selections under a search option.

Advanced
Search

Sewri niiens

» Browse 'Florida’

Home Competency Assessment Resources Discussions Help ‘ lSearch by Keyword or Course IDI Qy

» Browse All
sé\rqh Search our database of courses by selecting a search option.
» By Course ID it
» By Subject
» By Audience \
By Corpgetencies and Bro%b Browse through the entire database of Public Health Education and Training Opportunities.
Capabilities 3
» By Format
» By Credit Type
» By Sponsor/Offerer
» By Date
» By Distance
» By Accreditation
» By Certificate
» Keyword Search
» By Training plan
» By Language

-

| f st Save unlimited search profiles for future inquiries and receive email notification of new courses that match each search. After
n q. ) selecting your search criteria, click the “Save Search” button.

» Advanced Search

» Saved Search Criteria
—

Image 4.26

You can use the Search feature to find courses in the database by Subject.
You can Browse through the entire database for training courses.

The following sections will show you how to use the Search Options.

Table of Content Next Page
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Please note: regardless of which type of search option you use, TRAIN Florida will display the following
course information:

o Title

e Sponsor/Owner
o Format

e Rating

Use the navigation options listed on the top or bottom portion of the page to help locate your course.

Tip! To sort by any column, click the column heading.

20rowsperpage V| Fitr * ABCDEFGHIJKLMNOPQRSTUVWXY Z|AI
Select page within selected letter: LI_QJLLJ2 Sl s s AR B i muu Displaying page 1 of 12, items from 1 to 20 of 227|

s ot [Tite]

Image 4.27

Tip! To view course description, click on the Course Title

20rowsperpage V| Fitr *ABCDEFGHIJKLMNOPQRSTUVWXY Z|AI
Select page within selected letter: me 3045 6 7849 10 l_’Jlll Displaying page 1 of 12, items from 1 to 20 of 227|
S oW Sponsor/Offerer Format Rating

Image 4.28

—

Tip! Alphabetical page indexing is used when sorted by Title, Sponsor/Offerer or Format.

20 rows per page VIFiIter ’ABCDEFGHIJKLMNOPQRSTUVWXYZ
Select page within selected letter: wmm2 Ja4 5 160 785940 mw Displaying page 1 of 12, items from 1 to 20 of 227|

$ oW Sponsor/Offerer Format Rating

Image 4.29

—

Tip! Filter your search by selecting a “letter”. For example, if you select the letter H, it will display all
courses beginning with the letter H.

20rowsperpage V| Fiter *ABCDEF GH[I JKLMNOPQRSTUVWXY Z[al
Select page within selected letter: wwﬁp 3456 7 8.9 40 mw Displaying page 1 of 12, items from 1 to 20 of 227
$ oW Title Sponsor/Offerer Format Rating

Image 4.30

—

Tip! You can click the Save Criteria on any Course Search or Search Results page to save your
search criteria.

Table of Content Next Page




How to Use the Search Options

8 8 ® CONNECTING YOU TO THE COMMUNITY

Section 4.4

Browse 'Florida’

When you click the Browse 'Florida' search option, it will display a page listing all active TRAIN

Florida courses assigned by the TRAIN Florida Course Providers.

Search Options

Course Search

bﬂm.\!ss_'ﬂmdall
» Browse All

» By Course ID

» By Subject

» By Audience

> By Cof_n_pelencies and
Capabilities

» By Format

» By Credit Type

» By Sponsor/Offerer

» By Date

» By Distance

» By Accreditation

» By Certificate

» Keyword Search

» By Training plan

» By Language

» Advanced Search

» Saved Search Critena

Search Parameters v

Search Result I

Tip: To sort by any column, click the column heading.

Tip: To view course description, click on the Course Title

Tip: Alphabetical page indexing s used when sorted by Title, Sponsor/Offerer or Format.
$ = Fee associated with the course ~ #% = Credit is offered

20rowsperpage V| Fiter *ABCDEFGHIJKLMNOPQRSTUVWXYZAI
Seleclpagemhmseiectedle\!erl‘u_jl_(_‘E]z 345678910 . L!_ILNJ
S o Title Sponsor/Offerer Format Rating

Displaying page 1 of 12, items from 1 to 20 of 227]

Web-based
Training - Self-
study

dededededk (1)

i I Inc 5.0 out of 5 stars

APD - Attain_Inc_Health Insurance Portability Agency for Persons with Disabilities - Attain,
and Accountability Act (HIPAA)
Arc of Florida- Fl

Care for with D Webhaed

Training - Self-
study

sk ke (5)
5.0 out of 5 stars

Caregivers”
Arc of Florida- FHC & FHEC present: Web-based
i 3 Arc of Florida Training - Self-
inding Affordable Rental Housing™
study
- Fl nt Web-based
to Florida's State-Funded Arc of Flonida Training - Self-
Affordable Housing Programs™ study
Web-based
Training - Self-
study

sk (5)
5.0 out of 5 stars

dekkkk 2)
5.0 out of 5 stars

USF Center for Leadership in Public Health
Practice

dedededy: (47)

Basic Epidemiology
4.3 out of 5 stars

Note: Use the navigation options instructions listed in Section 4.3.

Section 4.5

Browse "All'

When you click on the Browse "All' search option, it will display a page listing all active courses

assigned by National and TRAIN Florida Course Providers.

Search Options

» Browse 'Florida'

» By Course ID

» By Subject

» By Audience

» By Competencies and
Capabilities

» By Format

» By Credit Type

» By Sponsor/Offerer

» By Date

» By Distance

» By Accreditation

» By Certificate

» Keyword Search

» By Training plan

» By Language

» Advanced Search

» Saved Search Criteria

Course Search

Search Parameters

Search Result

Tip: To sort by any column, click the column heading

Tip: To view course description, click on the Course Title

Tip: Alphabetical page indexing is used when sorted by Title, Sponsor/Offerer or Format.
$ = Fee associated with the course % = Credit is offered

20 rows per page V| Fiter *ABCDEFGHIJKLMNOPQRSTUVWXYZAI
Select page within selected letter: &mz 3456788910 .. ILJLL Displaying page 1 of 142, items from 1 to 20 of 2833
$ o Title Sponsor/Offerer Format Rating

National Network of Public Webstream/Archived
Health Institutes (NNPHI) Webcast

dedededk ' (52)
4.1 out of 5 stars

Web-based Training -
Self-study

Web-based Training -
Self-study
Web-based Training -
Self-study

Web-based Training -
Self-study

kmi (no reviews)
South Central Public Health
Partnership
South Central Public Health
Partnership
South Central Public Heaith
Partnership

dededeok((12)
3.8 outof 5 stars

wekedede (6)
4.2 out of 5 stars

wedkkdok (6)
4.8 out of 5 stars

Image 4.31




@99 & CONNECTING YOU TO THE COMMUNITY

Section 4.6

By Course ID

When you click on the By Course ID search option, it will display a page for you to enter the course ID.

Search Options

» Browse 'Florida’
» Browse All

» By Subject
» By Audience
By Competencies and
¥ Capabilities
» By Format
» By Credit Type
» By Sponsor/Offerer
» By Date
» By Distance
» By Accreditation
» By Certificate
» Keyword Search
» By Training plan
» By Language

» Advanced Search

» Saved Search Criteria

CourselD: [1058485 |«

Image 4.31

Section 4.7

By Subject

When you click on the By Subject search option, it will display a page for you to select your search
criteria. For the best results:

Search Options
» Browse 'Florida’

Course Search

Tip: To make multiple selections under a search option, hold down the CTRL key to select more than one option from the list.

» Browse All Subject

» By Course ID

» By Audience
By Competencies and
> Capabilities

» By Format

» By Credit Type

» By Sponsor/Offerer
» By Date

» By Distance

» By Accreditation

» By Certificate

» Keyword Search
» By Training plan

» By Language

» Advanced Search

» Saved Search Criteria

=> B

Computer Skills/Training

Cultural Competence

Education/Training/Exercises/Drills
mergency Managemen

Emergency Medical Services

Environmental / Industrial Health

Epidemiology / Biostatistics

O clinical on-cllnlcal O Both
O Local [®]an
["IFree courses only

And Keyword
Tip: Use "OR" or "AND" to better define your selected keyword search criteria.
Tip: To search for an exact phrase (e g, "vaccine administration”), use quotation marks.

["AND" Core Competencies |
O Course Title
@) Description

[®)sotn
] [Sswcien |

Image 4.31

Table of Content

v' Select the subject area in the
text box.

Click the Non-Clinical radio

button.

Click the All radio button.

Optional: enter a keyword using

the following tips:

L Use "OR" or "AND" to better
define your selected keyword
search criteria.

L To search for an exact phrase
(e.g., "vaccine
administration"), use quotation
marks.

v' Click the Both radio button.
v" Click the Search button.
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Section 4.8
By Audience

When you click on the By Audience search option, it will display a page for you to select your search
criteria. For the best results:

Search Options.

» Browse 'Florida’
» Browse All

Tip: To make multiple selections under a search option, hold down the CTRL key to select more than one option from the list
Audience

» By Course ID

» By Subject

E—
By Competencies and

» Capabiliies

» By Format

» By Credit Type

» By Sponsor/Offerer

» By Date

» By Distance

» By Accreditation

» By Certificate

» Keyword Search

» By Training plan

» By Language

» Advanced Search

» Saved Search Critenia

Duties/Functions:

Epidemiologists / Surveillance Stff
Fire Service

General Public Health Staff

Hazardous Matenials Personnel
Healthcare

Human Services

Senior Level-non supervisory staff
Volunteer

O clinical -Clinlcal O Both
OLocal [@lan

IFree courses only
And Keyword
Tip: Use "OR" or "AND" to better define your selected keyword search criteria
Tip: To search for an exact phrase (e.g., "vaccine administration”), use quotation marks.

[

O Course Title
(e) Description

[@lgotn
[[Search | [ Save Criteria

Image 4.32 I

v

Select your Job Duty or Functions

in the text box.

Select your Background Role in the

text box.

Click the Non-Clinical radio button

Click the All radio button.

Optional: enter a keyword using the

following tips:

O Use "OR" or "AND" to better
define your selected keyword
search criteria.

O To search for an exact phrase
(e.g., "vaccine administration"),
use quotation marks.

Click the Both radio button.

Click the Search button.

Section 4.

9

By Competencies and Capabilities

When you click on the By Competencies and Capabilities search option, it will display a page for you

to select your

search criteria. For the best results:

Search Options
» Browse ‘Flonda'
» Browse All

» By Course ID
» By Subject
» By Audience

» DY Competencies and
Capabilies

» By Format

» By Credit Type

» By Sponsor/Offerer
» By Date

» By Distance

» By Accreditation

» By Certfficate

» Keyword Search

» By Training plan

» By Language

» Advanced Search

» Saved Search Criteria

Competencies and Capabilities.

Core Competencies for Public Health Professionals

41 I7] Tier One
o 7] Tier Two
+ 7] Tier Three

O cinical n-clnlul O gotn

© Local n

I Free courses only

Tip: Use "OR" or "AND" 1o better define your selected keyword search criteria.
Tip: To sear:h for an exact phrase (e.g , "vaccine administration”), use quotation marks.

[

]

O course Tre
O Description

[@lsotn

v
v

Select the Core Competency Tier.
Click the Non-Clinical radio button.
Click the All radio button.

Optional: enter a keyword using the

following tips:

O Use "OR" or "AND" to better
define your selected keyword
search criteria.

O To search for an exact phrase
(e.g., "vaccine administration"),
use quotation marks.

Click the Both radio button.

Click the Search button.

Image 4.33 I
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Section 4.10
By Format

When you click on the By Format search option, it will display a page for you to select your search
criteria. For the best results:

sern o ey . Select your Format type in the text

» Browse 'Florida' Tip: To make multiple selections under a search option, hold down the CTRL key to select more than one option from the list. bOX .

R Click the Non-Clinical radio button.
:E{m’” $j On Click the All radio button.
e | - Webcationdemand) Optional: enter a keyword using the

By Competencies and i
& Cgpahilih'es i Webstream/Archived Webcast

4 e Event following tips:
By Credit Ty i 3 " n n "
4 sl || udoconfrsce O Use "OR" or "AND" to better

. Meetin .
i [ e ——— define your selected keyword

» By Accreditation

» By Certificate dcnmeau [®Inon-ciinicat O Botn search criteria.
i Ooca O Q To search for an exact phrase

o o (e.g., "In-Service"), use quotation

» Advanced Search Tip: Use "OR" or "AND" to better define your selected keyword search criteria.
—_— Tip: To search for an exact phrase (e.g., "vaccine inistration”), use quotation marks. m ar kS

Saved Search Criteria ["AND" In-service Traini ) .
’ Gt Click the Both radio button.

O pesc ription

[©leon Click the Search button.
e

Image 4.34

Section 4.11
By Credit Type

When you click on the By Credit Type search option, it will display a page for you to select your search
criteria. For the best results:

v' Select your Credit type in the text
Seareh Optons box.
< g e Click the Non-Clinical radio button.
T Z Click the All radio button.
:Ezéﬁ%;mm A Optional: gntgr a keyword using the
> Conois oo followmgu tIpS". ) )
e S ——— a Use "OR" or "AND" to better
» By e O Local[@]an define your selected keyword
EE;'EZE“ZTZ ET:;‘;:":"' _ search criteria.
> Kepvors Sare . T o e pase 05, e s e qooon s QO To search for an exact phrase
iy e (e.g., "In-Service"), use quotation
> s Swch ™" marks.
= Click the Both radio button.

Click the Search button.
Image 4.35 I
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Section 4.12

By Sponsor/Offerer

When you click on the By Sponsor/Offerer search option, it will display a page for you to enter your
search criteria. For the best results:

Search Options

» Browse 'Florida"
» Browse All

» By Course ID
» By Subject
» By Audience
By Competencies and
¥ Capabilities
» By Format
» By Credit Type
» By Sponsor/Offerer I
» By Date
» By Distance
» By Accreditation
» By Certificate
» Keyword Search
» By Training plan
» By Language

» Advanced Search

» Saved Search Criteria

Sponsor/Offerer

PPCourse Searcn

=0 | Agency For Persons with Disabilites

Agency for Healthcare Research and Quality (AHRQ)
Agency For Persons with Disabilites

Enter at least three letters and the
drop-down box will dsiplay the
lookup list,(e.g., "Agency").

From the drop-down list, click on the
Sponsor/Offerer name.

Click the Search button.

Image 4.36

Section 4.13

By Date

When you click on the By Date search option, it will display all Live Event (Classroom) trainings.

Show the Calendar Events

Search Options

» Browse 'Florida’
» Browse All

» By Course ID

» By Subject

» By Audience

. By Competencies and
Capabilities

» By Format

» By Credit Type

» By Sponsor/Offerer

» By Distance

» By Accreditation

» By Certificate

» Keyword Search

» By Training plan

» By Language

» Advanced Search

» Saved Search Criteria

Course Search

(® Show the Calendar Events

() Events in Date Range

B FDOH 2016 Division 6.2 Infectious Substances Packa - Learning Event
03721/2016
9:00 AM-4:30PM CT
FDOH Bay County Health Department

Course Title: FDOH 2016 6.2 Infectious Substances Packaging and Shipping
TrainingCourse Duration: & hours (All sessions are scheduled from 9.00 am to 4:30 pm|
but may run longer)Course Description: Inf...|detail

Click to view course details

Table of Content
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The page shows the calendar
events for the current date.
Click on a calendar day to view
the scheduled calendar event (s)
Click on the “Detail” link to see
course details.

O You can register for the
course on the course details
page.

Use the calendar navigation to

search for future courses.
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You can search for Live Events (Classroom) trainings by using the Events in Date Range option.

Events in Date Range

Search Options

» Browse 'Florida"
» Browse All

» By Course ID

» By Subject

» By Audience
By Competencies and
Capabilities

» By Format

» By Credit Type

» By Sponsor/Offerer

» By Date

» By Distance

» By Accreditation

» By Certificate

» Keyword Search

» By Training plan

» By Language

» Advanced Search

» Saved Search Criteria

O Show the Calendar Events

I ® Events in Date Range I
Start Date:

End Date:

Enter a search start date using this format:

3/22/2016.

Enter a search end date using this format:

5/22/2016.

Click the Show Events button.

U You can register for the course on course
details page.

Use the calendar navigation to search for

future courses.

Image 4.38

Section 4.14

By Distance

When you click on the By Distance search option, it will display a page for you to enter your
search criteria. For the best results:

Search Options

» Browse 'Florida'
» Browse All

» By Course ID

» By Subject

» By Audience

> By Cor_n_qetencies and
Capabilities

» By Format

» By Credit Type

» By Sponsor/Offerer

» By Date

» By Accreditation

» By Certificate

» Keyword Search

» By Training plan

» By Language

» Advanced Search

» Saved Search Criteria

Distance

In radius of: miles

v

v

v

Enter the distance in radius of miles you are
willing to travel from your current location.
Click the Search button.

The search results page will display all Live
Events (Classroom) trainings within your
search criteria.

Image 4.39 I
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Section 4.15

By Accreditation

When you click on the By Accreditation search option, it will display a page for you to select your

search criteria.

For the best results:

Search Options

» Browse Flonda'

» Browse Al Accreditation

Course Search

Tip: To make muitiple selections under a search option, hold down the CTRL key to select more than one option from the list.

» By Course ID

» By Subject

» By Audience

» BY Competencies and
Capabilties

» By Format

» By Credit Type

» By Sponsor/Offerer

» By Date
» By Distance

> rificate
» Keyword Search
» By Training plan
» By Language

» Advanced Search

» Saved Search Criteria

heaith education by the National Commission for Health Education Credentialing, Inc. COC provider # GAO0B2
~
Centers for Disease Control and Prevention - CEU - COC has been approved s an Authorized Provider by the Intemational

Association for Continuing Education and Training (IACET).
Certified Environmental Health Technician (CEHT) - NEHA

Certified Installer of Onsite Wastewater Treatment Systems (CIOWTS) - NEHA

CEU - Wichita State University has been approved by the Kansas Behavioral Sciences Regulatory Board for continuing education
for social workers. (SRB approval #05-001)
CEU - American Health Information Management Assocation (AHIMA)

CEU - Texas State Board of Examiners of Professional Counselors (LPC)

O ciinical [@Non-Clinical © Both
O Local [®]an
[“IFree courses only

And Keyword
Tip: Use "OR" or "AND" to better define your selected keyword search criteria
Tip: To search for an exact phrase (e g., “vaccine administration”), use quotation marks

O Course Title
O Description

[®lgotn

Image 4.40

Select the Accreditation type in the

text box.

Click the Non-Clinical radio button.

Click the All radio button.

Optional; enter a keyword using the

following tips:

O Use "OR" or "AND" to better
define your selected keyword
search criteria.

O To search for an exact phrase
(e.g., "In-Service"), use quotation
marks.

Click the Both radio button.

Click the Search button.

Section 4.16

By Certificate

When you click on the By Certificate search option, it will display a page for you to select your search
criteria. This page will show all courses assigned to the certificate. For the best results:

Search Options
» Browse 'Florida"
» Browse All

_
Tip: To make multiple selections under a search option, hold down the CTRL key to select more than one option from the list.
Certificate

» By Course ID

» By Subject

» By Audience

> By Competencies and
Capabilities

» By Format

» By Credit Type

» By Sponsor/Offerer

» ByDate

» By Distance
By Accreditation

» Keyword Search

» By Training plan

» By Language

» Advanced Search

» Saved Search Critena

APD Generic Cerfificate

Arc FL - "Finding Affordable Rental Housing" Certificate

Arc FL- "Disability and Health- Module 1" Certificate

Arc FL- "Disability and Health- Module 2" Certificate

| Arc FL- "Disability and Health- Module 3" Certificate

Arc FL- "Oral Health for Caregivers Presentation" Certificate

O ciinical [€]Non-Cinical O Both
O Local [@]an

[J Free courses only

And Keyword
Tip: Use "OR" or "AND" to better define your selected keyword search criteria
Tip: To search for an exact phrase (e.g., "vaccine ). use quotation marks.

O course Title
O Description
©®Both

Table of Content
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Select the Certificate in the text box.
Click the Non-Clinical radio button.
Click the All radio button.

Optional: enter a keyword using the
following tips:

O Use "OR" or "AND" to better
define your selected keyword
search criteria.

To search for an exact phrase
(e.g., "In-Service"), use quotation
marks.

v Click the Both radio button.

v Click the Search button.

Q




@99 & CONNECTING YOU TO THE COMMUNITY

Section 4.17

Keyword Search

The Keyword Search option is the recommended way to find courses. When you click on the
Keyword Search option, it will display a page for you to select your search criteria. The results page
will display a listing all active courses, conferences, resources, announcements, discussions, links
assigned by the National and TRAIN Florida Administrators, and Non-Train Events assigned by
National and TRAIN Florida Course providers. For the best results:

Search Options
» Browse 'Florida'
» Browse All

v" Click the Non-Clinical radio button

Tip: To launch search function, please click on Search button. Starting search by pressing Enter key temporarily is not available.
Keyword

v" Click the All radio button.

» By Course ID

» By Subject

» By Audience

> By Car_v!pe(encies and
Capabilities

» By Format

» By Credit Type

» By Sponsor/Offerer

» By Date

» By Distance

» By Accreditation

» By Certificate

» By Training plan

» By Language

» Advanced Search

» Saved Search Criteria

O clinical Non-CIInlcal O Both

O Local @Au

["IFree courses only

Tip: Use "OR" or "AND" to better define your selected keyword search criteria.
Tip: To search for an exact phrase (e.g., "vaccine administration”), use quotation marks.

v" Click all content types that apply

v Optional: enter a keyword using the
following tips:
U Use "OR" or "AND" to better

Content Type:
M course ¥ Conference I Resources ¥ Announcement ¥ Discussion M Link [V Non-TRAIN Event

define your selected keyword

|"AND" "HIPAA"

] search criteria.

OTitle
(0] Description
®8oth

O To search for an exact phrase
(e.g., "HIPAA"), use quotation
marks.

v" Click the Both radio button.
v' Click the Search button.

Image 4.42

Section 4.18

By Training plan

When you click on the By Training Plans search option, it will display all training plans shared at
the National level.

Search Options
» Browse 'Flonda'
» Browse All

» By Course ID

» By Subject

» By Audience

» By Competencies and
Capabilities

» By Format

» By Credit Type

» By Sponsor/Offerer

» By Date

» By Distance

» By Accreditation

» By Certificate

» Keyword Search

> nguage

» Advanced Search

Course Search

Training Plan Name

Basics of Public Health
Preparedness

Description

These ten introductory, online trainings provide the main concepts of public health preparedness. Each module
can be comple(ed within |5 minutes to 50 minutes. Modules include: Module 1: Introduction to Public Health

» Saved Search Critena

P for Prep. Staff Module 2: Public Health Preparedness Planning Module 3: Public Health
Preparedness Exercrses Module 4: Medical C Module 5: R Health and Safety Module 6
Occupational Health for Public Health Responders Module 7: Disaster Behavioral Health Module 8: Working with
Community Partners Module 9: Disaster Epidemiology Module 10: Risk C: Modules are for
sta" from state and local health depanmenls This training was developed with the support of the UNC

and Emergency POl Leammg Cenm (UNC PERLC), a funded project of the Centers for
Dlsease Control and F (CDC 1US0TP000415). The UNC PERLC gratefully
acknowledges the contributions of the West Virginia Center for Threat Preparedness and the North Carolina Public
Health Preparedness and Response Branch in shaping the content and framework for this training

Trainin

CDC's Diwision of ion and F D the Public Health 101 Training
Plan. The Public Health 101 Series contains six courses that mtroduce learners to public health and the core
sciences of public health practice. The series is ¢ d of the courses: | tion to Public
Health «| d to Public Health Informatics *Introduction to Public Health
Surveill d to P Effects d to Public Health Laboratories Each course
contains definitions and key terms, the public health approach, an overview of the core topic, knowledge checks,
and references. The Public Health 101 Series can benefit the following groups: *Those who work in public heaith
but who have not had Votmal training in a pamcular core area *Those who have had public health education and
would like a or others i d in pursuing careers in public health sHealth educators and
instructors responsible for the training and professional development of the public health workforce Each course
takes between 40 and 60 minutes to complete. The first course, Introduction to Public Health, is required for the
training plan and you are encouraged to select one or more of the optional courses to round out your public health
101 needs
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Section 4.19
By Language

When you click on the By Language search option, it will display a page for you to select your search
criteria. For the best results:

search options oo i

>Bmu:p'::ua‘ | Tip: To make multiple sefections under a search option, noid down the CTRL key 10 select more than one option rom the list. / Se.lec.t the Language type- In the teXt bOX'
b e | rooumee = v Click the Non-Clinical radio button.

» e 7 " English . .
b g ioomon it v Click the All radio button.
» By Audience I Arabie

S Dleenga v' Optional: enter a keyword using the
> ovos e following tips:

[CIFarsi
s B O Use "OR" or "AND" to better define your
F . i) selected keyword search criteria.
;_EE;; vl a To S(_earch for an exact phrase (e.g., "In-
C Flkoean Service"), use quotation marks.

» Advanced Search CImanaann

T Clobw v Click the Both radio button.
e v" Click the Search button.

I soman
[Ispansn

[ Tagaiog
[Cvietnamese

Ccunical mcm OBoth

© Local [Slan
[ Free courses only
And Keyword

Tip: Use "OR” or "AND" to better define your selected keyword search crtena.
Tip: To search for an exact phrase (e g, “vaccine administration”), use quotation marks

]

<;cmneme
i
== Image 444

Section 4.20
Advanced Search

When you click on the Advanced Search option, it will display a page for you to select your
search criteria. You can use any of the following to search for courses:

By Subject

By Audience

By Competencies and Capabilities
By Format

By Credit Type

By Sponsor/Offerer
By Date

By Distance

By Accreditation
By Certificate
Keyword Search
By Language,

By Training Plans
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Section 4.21
Saved Search Criteria

You can click the Save Criteria button on any Course Search or Search Results page to save your
search criteria. For the best results:

SA 8 Optoms Pourse Searen Click the Save Criteria button

» Browse 'Florida" Saved Search Criteria

S Beowsa Al Enter name for the new search

» By Course ID Please enter name for the new search criteria [HIPAA criteria.

> gyi:db?eﬂ Noﬁfyrneabomcoursessatisfyingthissearchcrneria@ CheCk the N0t|fy me abOUt
» By ience . . -
» 8 Comoctencies ng courses satisfying this search

» By Fomat criteria, box ( To get an email, you
L e must Opt-in to receive emails

» By Sponsor/Offerer

> By Date from TRAIN Florida)
o o Click the Submit button.

» By Certificate
» Keyword Search
» By Training plan
» By Language

» Advanced Search

» Saved Search Criteria

Here is how to manage the Saved Search Criteria.

When you click on the Saved Search Criteria search option, it will display a page for you to manage
your Saved Search Criteria.

Tips:

Seac Optons ProoureSearen mmm

» Browse 'Florida’ Saved Search Criteria i o
» Brouse Al o e — E—— v Click the pencil icon change the
— e search information.

» By Course ID
» By Subject

» By Audience This is the date and time Click the “X” to delete the Saved

" f the last saved search.

By Competencies and o .

> Capaiis Search Criteria.
» By Format

» By Credit Type

» By SponsorOffrer Click the Search Criteria link to
i run the Search Criteria.

» By Accreditation
» By Cerificate
» Keyword Search
» By Training plan
» By Language

» Advanced Search

» Saved Search Criteria

Table of Content Next Page




Q0

® 88 & CONNECTING YOU TO THE COMMUNITY

Section 5
Who to Contact for Help & Support

When to Contact the Course Provider

For help or questions with the training content, presentation materials, or the presentation, please
contact the Course Provider. They will provide you with answers to resolve your problems.

Follow the steps in Section 3.1 of this document to locate the Course Provider information. Locate
section 3.1.2.b, click on the Contacts tab. The page will show you the Course Provider's name,
telephone number and email address.

X X X :
Course Details |Contacts| \  Registration \ Reviews \ Image 5.1

TIP! Please review the Course Details. The Course Provide may have include special course
instructions.

When to Contact the TRAIN Florida APD LMS Support team

APD Technical Support and Communication

We are just an email away!

If you have any problems and require technical assistance, please contact the TRAIN Florida APD
site administrator by email: apd.Imssupport@apdcares.org.

Image 5.3 I

Do not to contact the Florida Department of Health or the Public Health Foundation for
assistance. Thank you for supporting TRAIN Florida APD.
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